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ABSTRACT 

  

A wind tunnel is an equipment especially used in aerodynamic research to study the 

effects of air moving past solid objects. A systematic investigation into the design and 

simulation of flow parameters of a redesigned closed-loop wind tunnel was carried 

out using Computational Fluid Dynamics (CFD) where the inlet conditions of the 

flow are obtained by applying Continuity equation at the effuser and test section. As it 

is a subsonic wind tunnel, a suitable velocity at the test section has to be considered 

and the corresponding inlet velocity is obtained. The standard model of closed loop 

wind tunnel-rectangular type is modified to triangular type using Solid works in order 

to reduce the number of corners thereby reducing overall head loss. The problems 

encountered on using a closed loop wind tunnel are generation of heat due to repeated 

circulation of air, head loss due to radiators. These problems are solved by designing a 

Guide vane radiator which is used for directing the air for circulation, cooling the 

circulating air and reducing overall head loss. Heat transfer in the guide vane radiators 

takes place to which necessary equations are applied to get the conditions of inlet 

water flow 

A triangular shaped closed loop wind tunnel with Guide vane radiator is designed and 

simulated. 
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1.INTRODUCTION 

 

1.1 INTRODUCTION TO WIND TUNNEL: 

Wind tunnels are large tubes with air moving inside. The tunnels are used to copy the 

actions of an object in flight. Researchers use wind tunnels to learn more about how 

an aircraft will fly. Some wind tunnels are big enough to hold full-size versions of 

vehicles. The wind tunnel moves air around an object, making it seem like the object 

is really flying. 

Most of the time, powerful fans move air through the tube. The object to be tested is 

fastened in the tunnel so that it will not move. The object can be a small model of a 

vehicle. It can be just a piece of a vehicle. It can be a full-size aircraft or spacecraft. It 

can even be a simple object like a tennis ball. The air moving around the still object 

shows what would happen if the object were moving through the air. How the air 

moves can be studied in different ways. Smoke or dye can be placed in the air and can 

be seen as it moves. Threads can be attached to the object to show how the air is 

moving. Special instruments are often used to measure the force of the air on the 

object. 

The development of wind tunnels accompanied the development of the airplane. 

Large wind tunnels were built during World War II. Wind tunnel testing was 

considered of strategic importance during the Cold War development of supersonic 

aircraft and missiles 

The advances in computational fluid dynamics (CFD) modelling on high speed digital 

computers has reduced the demand for wind tunnel testing. However, CFD results are 

still not completely reliable and wind tunnels are used to verify CFD predictions. 

1.1.1. CLASSIFICATION OF WIND TUNNELS: 

Wind tunnels may be classified based on any of the following: 

• Speed , Mach no: 

They are classified as low speed or high speed wind tunnels. In wind tunnel 

parlance, high speed wind tunnels are those operating at speeds where 
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compressibility effects are important. They are also classified based on Mach 

no of operation as subsonic, transonic, supersonic or hypersonic wind tunnels. 

• Mode of operation (Pressure storage, in-draft or Pressure vacuum type). 

• Kind of test section (T.S) – Open, Closed or Semi enclosed. 

 

1.1.1.1.Classification based on Speed, Mach no: 

Mach Number : 

The Mach number is the ratio of flow velocity after a certain limit of the sounds 

speed. In simple words it is the ratio of the speed of a body to the speed of sound in 

the surrounding medium. 

Mach Number (M) = u/c 

where, M is Mach number, 

u is local flow velocity (m/s) 

c is speed of sound in that medium(m/s) 

Speed below the speed of sound is termed as subsonic whereas speed above the speed 

of sound is termed as supersonic, although scientists practicing aerodynamics most of 

the time use these terms to describe a particular range of Mach values. 

Regime Subsonic Transonic Sonic Supersonic Hypersonic High 

Hypersonic 

Mach 

No. 

<0.8 0.8-1.3 1.0 1.3-5 5-10 >10 

Table.1.1. Mach speeds 

• Subsonic: 

The Mach is below 0.8. 

• Transonic: 

Aircrafts that are built with swept wings. The Mach value is between 0.8-2.1. 

• Supersonic: 

The aircrafts created to go supersonic have a definite design it has complete 

movement of the canards, thin aerofoil sections, and sharp edges. The Mach 

levels are between 1.2 and 5.0. 
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• Hypersonic: 

These planes have several distinctive features such as nickel-titanium skin that 

is cooled and small wings. The Mach values are between 5.0 and 10.0. The 

U.S. plane X-15 created the world record of flying at Mach 6.72. 

• High- Hypersonic: 

The Mach levels are between 10.0 -25.0. When flying at such huge speeds 

thermal controls becomes an integral portion of the design. The hotness of the 

surface must be considered beforehand. 

1.1.1.2 Classification based on Mode of operation: 

• Pressure storage type: 

In one such tunnel, air expands from high pressure to the atmospheric pressure 

where low pressure chamber is excluded (intermittent blow down tunnel). In 

other cases, the atmospheric air can expand up to a very low vacuum 

(intermittent in-draft wind tunnel). 

 

Fig.1.1 Pressure storage type wind tunnel 

• Pressure vacuum type : 

A wind tunnel that is open on both ends and draws air from the room into text 

section is called open return tunnel. A blow down wind tunnel as a high 

pressure vessel upstream of test section and a low pressure reservoir 

downstream of the test section 
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Fig.1.2. presuure vacuum wind tunnel 

1.1.1.3.Classification based on kind of test section: 

• Open loop Wind Tunnel 

 

Fig.1.3. Open Loop Wind Tunnel 

In the open tunnel, the air that passes through the test section is gathered from 

the room in which the tunnel is located. The arrows on the figure denote the 

flow of air through the wind tunnel and around the room. 

 

• Closed Loop Wind Tunnel 

https://www.grc.nasa.gov/www/k-12/airplane/tunpart.html
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Fig.1.4. Closed loop wind tunnel 

In the closed return tunnel, air is conducted from the exit of the test section back to 

the fan by a series of turning vanes. Exiting the fan, the air is returned to the 

contraction section and back through the test section. Air is continuously circulated 

through the duct work of the closed return tunnel. The arrows on the figure denote the 

flow of air through the wind tunnel.  

Closed return tunnels may operate sub sonically or supersonically. Supersonic closed 

return tunnels are more complex than subsonic tunnels. To prevent condensation in 

the test section because of low pressure, the air entering the tunnel is often passed 

over a dryer bed. There is usually an additional throat placed in the tunnel 

downstream of the test section to shock down the supersonic flow to subsonic. 

Advantages of closed loop wind tunnel over open loop wind tunnels: 

• Power requirement for a given speed is lower. 

• Particulate matter can be contained within the circuit. 

• Noise is significantly lower. 

• Laboratory air movement (air vents, doors, windows, etc.) does not affect wind 

tunnel flow. 

• Air entering the test section is free of laboratory dust. 

• Fan blades are not as vulnerable to damage from model failure. 

 

https://www.grc.nasa.gov/www/k-12/airplane/tunpart.html
https://www.grc.nasa.gov/www/k-12/airplane/tunnozt.html
https://www.grc.nasa.gov/www/k-12/airplane/normal.html
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1.1.2. COMPONENTS OF CLOSED LOOP WIND TUNNELS: 

 

1.1.2.1.Settling chamber and flow straightener: 

It mainly comprises of honeycomb and screens as combination. The main 

function is to reduce the turbulence and straighten the flow only in the axial 

direction. In this, the air can enter to the tunnel from any directions. But, only 

the axial flow is desired in the test section. The main purpose of the screen is 

to reduce the turbulent intensity in the flow and not to allow any unwanted 

objects to enter the tunnels. The honeycomb can be made with cells or various 

shapes. These cells are aligned in the stream wise direction in the settling 

chamber thereby straightens the flow. The honeycomb has a longer length that 

reduces the transverse velocity components of the flow with minimal pressure 

drop in the stream wise direction. 

1.1.2.2.Contraction: 

The prime objective is to accelerate incoming flow from the settling chamber 

and supplies it to the test section at desired velocity. This section essentially 

reduces the cross-sectional velocity variation and maintains the flow 

uniformity. In general, small radius of curvature is used at the entry to this 

section and curvature of large radius is considered at the exit of the contraction 

section. However, the boundary-layer separation should be avoided at both the 

ends of this section. The contraction length is expected to be small so that 

large contraction area ratios are preferred. 

1.1.2.3.Test Section: 

It is the basic element of wind tunnel on which all other designs are generally 

made. All the aerodynamic models are mounted in the test section when the 

tunnel is operated with desired flow velocity. Various shapes for the test 

section are considered for constructing the wind tunnel viz. hexagonal, 

octagonal, rectangle etc. The test section is generally designed on the basis of 

utility and aerodynamic considerations since cost of construction depends on 

the test section area. Length of the test section is mostly equal to major 
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dimension of the cross-section of the same or twice of it. In addition, the test 

section should also be provided with facilities as per the testing requirement. 

The test section velocity is generally specified as percentage variation from 

the average of the cross-section. The ideal test section has steady uniform 

velocity at the inlet, no cross flow, less or no turbulence and less operating 

cost. 

1.1.2.4.Diffuser:  

It is basically a duct with increase in area attached downstream of the test 

section. After the test section, it is desired that the air must pass smoothly out 

of the test section. So, this geometry is made to decrease the flow velocity and 

increase in pressure. In order to avoid flow reversal, the exit pressure should 

be higher than the atmospheric in case of open circuit wind tunnel. This is a 

very critical section in design since the incurred pressure rise reduces the 

power requirement for the wind tunnel which is proportional to the cube of 

velocity. Hence maximum pressure recovery to be achieved at least possible 

distance is the main objective of diffuser design. In general practice, the cone 

angle of the diffuse is 7º or less so as to avoid boundary layer separation. 

1.1.2.5.Turning vanes: 

In a closed-circuit wind tunnel, the air has to circulate in a controlled manner. 

Typically, the corners of the wind tunnel are of two bends. These corners are 

provided with turning vanes for smooth passage of the flow. Chambered 

aerofoils of bent planes are generally accepted as the turning vanes. These 

vanes are purposely made as adjustable for smooth operation thereby avoiding 

under/over tuning. 

1.1.3. HOW IT WORKS: 

Air is blown or sucked through a duct equipped with a viewing port and 

instrumentation where models or geometrical shapes are mounted for study. Typically 

the air is moved through the tunnel using a series of fans. The airflow created by the 

fans that is entering the tunnel is itself highly turbulent due to the fan blade motion 
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and so is not directly useful for accurate measurements. The air moving through the 

tunnel needs to be relatively turbulence-free and laminar. To correct this problem, 

closely spaced vertical and horizontal air vanes are used to smooth out the turbulent 

airflow before reaching the subject of the testing. In closed loop wind tunnel, as the 

same air is made to flow throughout the tunnel continuously, temperature increases. In 

order to reduce the effects caused due to temperature increase, necessary cooling 

technique has to be followed. 

1.1.4. MEASUREMENTS MADE USING WIND TUNNELS: 

1.1.4.1.Pressure measurements: 

Pressure across the surfaces of the model can be measured if the model 

includes pressure taps. This can be useful for pressure-dominated phenomena, 

but this only accounts for normal forces on the body. 

1.1.4.2.Force and Moment measurements: 

 

Fig.1.5. Typical lift coefficient versus angle of attack curve 

With the model mounted on a force balance, one can measure lift, drag, lateral 

forces, yaw, roll, and pitching moments over a range of angle of attack. This 

allows one to produce common curves such as lift coefficient versus angle of 

attack. 

Note that the force balance itself creates drag and potential turbulence that will 

affect the model and introduce errors into the measurements. The supporting 

structures are therefore typically smoothly shaped to minimize turbulence. 

1.1.5. APPLICATIONS OF WIND TUNNELS: 

      

https://en.wikipedia.org/wiki/Lift_coefficient
https://en.wikipedia.org/wiki/Angle_of_attack
https://en.wikipedia.org/w/index.php?title=Beam_Balance&action=edit&redlink=1
https://en.wikipedia.org/wiki/Angle_of_attack
https://en.wikipedia.org/wiki/Lift_coefficient
https://en.wikipedia.org/wiki/File:Lift_curve.svg
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      1.1.5.1. Aerodynamics applications: 

Wind tunnels provide a concentrated stream of air in a vertical or horizontal 

flow. Quite often wind tunnels are used in the testing of products, such as seen 

in the automotive industry, to develop aerodynamic designs. Wind tunnels are 

also utilized for recreational applications such as indoor skydiving facilities. 

      1.1.5.2. Non aerodynamic: 

Drag is often the component that receives the greatest attention as it has 

dominant effect on fuel consumption at a given speed and on the top speed 

attainable. The lift force is of extreme importance in determining 

controllability for performance cars and race cars, becoming more critical as 

the speed increases. 

They are also used in mechanical engineering, civil engineering, automobile 

engineering and calibration of instruments. 
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1.2. INTRODUCTION TO COMPUTATIONAL FLUID DYNAMICS 

1.2.1. CFD 

CFD is one of the branches of fluid mechanics that numerical methods and algorithms 

to solve and analyze problem that involve fluid flows. Computers are used to perform 

the millions of calculations required to simulate the interaction of fluid and gases with 

the complex surfaces used in engineering. However, even with simplified equations 

and high speed supercomputers, only approximate solutions can be achieved in many 

cases. More accurate codes that can accurately and quickly simulate even complex 

scenarios such as supersonic or turbulent flows are an ongoing area of research. 

1.2.2. GOVERNING EQUATIONS 

The governing equations of fluid flow represent mathematical statements of the 

conservation laws of physics. Each individual governing equation represents a 

conservation principle. The fundamental equations of fluid dynamics are based on the 

following universal laws of conservation. They are 

Unsteady state 3-D equation of continuity:- 

∂ ∂ρ    +   div   (ρ u) = 0 

∂ ∂t 

Momentum equation:- 

 ∂ (ρ u) + div (ρ u μ) = -∂ρ + div (μ grad u) 

∂t      ∂x 

 

Energy equation:- 

∂ (ρ i) + div (ρ I u) = -p div u + div (k grad T) + ϕ + S 

        ∂t 

1.2.3. DISCRETISATION METHODS OF CFD  

There are three discretization methods in CFD: 

1. Finite difference method (FDM) 

2. Finite volume method (FVM) 

3. Finite element method (FEM) 
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1.2.3.1. Finite difference method (FDM) 

A finite difference method (FDM) discretization is based upon the differential form of 

the PDE to be solved. Each derivative is replaced with an approximate difference 

formula (that can generally be derived from a Taylor series expansion). The 

computational domain is usually divided into hexahedral cells (the grid), and the 

solution will be obtained at each nodal point. The FDM is easiest to understand when 

the physical grid is Cartesian, but through the use of curvilinear transforms the 

method can be extended to domains that are not easily represented by brick-shaped 

elements. The Discretization results in a system of equation of the variable at nodal 

points, and once a solution is found, then we a discrete representation of the solution. 

1.2.3.2 Finite volume Method (FVM)  

A finite volume method (FVM) discretization is based upon an integral form of the 

PDE to be solved for a given finite volume (or cell). The computational domain is 

discretized into finite volume and then for every volume the governing equations are 

solved. The calculation of fluxes is very important in FVM. The basic advantage of 

this method over FDM is it does not require the use of structural grids, and the effort 

to convert the given mesh into structural numerical grid internally is completely 

avoided. As with FDM, the resulting approximate solution is a discrete, but the 

variables are typically placed at cell canters rather than at nodal points. This is not 

always true, as there are also face-cantered finite volume methods. In any case, the 

valves of field variables at non-storage locations (e.g. Vertices) are obtained using 

interpolation. 

1.2.3.3 Finite Element Method (FEM) 

A finite element method (FEM) discretization is based upon a piecewise     

representation of the solution in terms of specified basis functions. The computational   

domain is divided into smaller domains (finite elements) and the solution in each 

element is constructed from the basic functions. The actual equations that are solved 

are typically obtained by restarting the conservation equation in weak form: the field 

variables are written in terms of the basic functions; the equation is multiplied by 

appropriate test functions, a great deal more is known about the solution than for 

either FDM or FVM. This can be a double-edged sword, as the choice of basic 



 

12 
 

functions is very important and boundary conditions may be more difficult to 

formulate. Again, a system of equations is obtained (usually for nodal values) that 

must be solved to obtain a solution. 

Comparison of the three methods is difficult, primarily due to the many variations of 

all three methods. FVM and FDM provide discrete solutions, while FEM provides    

continuous (up to a point ) solution. FVM and FDM are generally considered easier to 

program than FEM, but opinions vary on this point. FVM re generally expected to 

provide better conservation properties, but opinions vary on this point also. 

1.2.4. WORKING OF CFD 

CFD codes are structured around the numerical algorithms that can be tackle fluid 

problems. In order to provide easy access to their solving power all commercial CFD 

packages include sophisticated user interface input problem parameters and the 

results. Hence all codes contain three main elements: 

1. Pre-processing. 

2. Solver 

3. Post-processing. 

 

1.2.4.1. Pre-processing: 

This is the first step in building and analyzing a flow model. Pre-processor consist of 

input of a flow problem by means of an operator-friendly interface and subsequent 

transformation of this input into form of suitable for the use by the solver. The user 

activities at the Pre-processing stage involve: 

• Definition of the geometry of the region: The computational domain. 

• Grid generation the subdivision of the domain into a number of smaller, non-

overlapping sub domains (or control volumes or elements selection of physical 

or chemical phenomena that need to be modelled). 

• Definition of fluid properties. 

• Specification of appropriate boundary conditions at cells, which coincide with 

or touch the boundary. The solution of a flow problem (velocity, pressure, 

temperature etc.) is defined at nodes inside each cell. The accuracy of CFD 
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solutions is governed by number of cells in the grid. In general, the large 

numbers of cells better the solution accuracy. Both the accuracy of the 

solution & its cost in terms of necessary computer hardware & calculation 

time are dependent on the fineness of the grid. Efforts are underway to 

develop CFD codes with a (self) adaptive meshing capability. Ultimately such 

programs will automatically refine the grid in areas of rapid variation. 

1.2.4.2. Solver: 

The CFD solver does the flow calculations and produces the results. FLUENT, FLO 

WIZARD, FIDAP, CFX and POLYFLOW are some of the types of solvers. 

FLUENT is used in most industries. Flo Wizard is the first general-purpose rapid flow 

modeling tool for design and process engineers build by Fluent. POLYFLOW (and 

FIDAP) are also used in a wide range of fields, with emphasis on the materials 

processing industries. FLUENT and CFX two solvers were developed independently 

by ANSYS and have a number of things in common, but they also have some 

significant differences. Both are control-volume based for high accuracy and rely 

heavily on a pressure-based solution technique for broad applicability. They differ 

mainly in the way they integrate the fluid flow equations and in their equation 

solution strategies. The CFX solver uses finite elements (cell vertex numeric), similar 

to those used in mechanical analysis, to discretize the domain. In contrast, the 

FLUENT solver uses finite volumes (cell centered numeric). CFX software focuses 

on one approach to solve the governing equations of motion (coupled algebraic multi 

grid), while the FLUENT product offers several solution approaches (density, 

segregated and coupled-pressure-based methods) 

The FLUENT CFD code has extensive interactivity, so we can make changes to the 

analysis at any time during the process. This saves time and enables to refine designs 

more efficiently, Graphical user interface (GUI) is intuitive, which helps to shorten 

the learning curve and make the modeling process faster. In addition, FLUENT’s 

adaptive and dynamic mesh capability is unique and works with a wide range of 

physical models. This capability makes it possible and simple to model complex 

moving objects in relation to flow. This solver provides the broadest range of rigorous 

physical models that have been validated against industrial scale applications, so we 

can accurately simulate real-world conditions, including multiphase flows, reacting 
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flows, rotating equipment, moving and deforming objects turbulence, radiation, 

acoustics and dynamic meshing. The FLUENT solver has repeatedly proven to be fast 

and reliable for a wide range of CFD applications. The speed to solution is faster 

because suite of software enables us to stay within one interface from geometry 

building through the solution process, to post-processing and final output. 

The numerical solution of Navier-Stokes equations in CFD codes usually implies a 

discretization method it means that derivatives in partial differential equations are 

approximated by algebraic expressions which can be alternatively obtained by means 

of the finite difference or the finite-element method. Otherwise, in a way that is 

completely different from the previous one, the discretization equations can be 

derived from the integral form the conservation equations: this approach, known as 

the finite volume method, is implemented in FLUENT, because of its adaptability to a 

wide variety of grid structures. The result is a set of algebraic equations through 

which mass, momentum, and energy transport are predicted at discrete points in the 

domain. In the freeboard model that is being described, the segregated solver has been 

chosen so the governing equations are solved sequentially. Because the governing 

equations are non-linear and coupled, several iterations of the solution loop must be 

performed before a converged solution is obtained and each of the iteration is carried 

out as follows: 

(1)Fluid properties are updated in relation to the current solution; if the calculation is 

at the first iteration, the fluid properties are updated consistent with the initialized 

solution. 

(2)The three momentum equations are solved consecutively using the current value 

for pressure so as to update the velocity field. 

(3)Since the velocities obtained in the previous step may not satisfy the continuity 

equation, one more equation for the pressure correction is derived from the continuity 

equation and the linearized momentum equations: once solved, it gives the correct 

pressure so that continuity is satisfied. The pressure-velocity coupling is made by the 

SIMPLE algorithm, FLUENT default options. 

(4)Other equations for scalar quantities such as turbulence, chemical species and 

radiation are solved using the previously updated value of the other variables, when 
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inter-phase coupling is to be considered, the source terms in the appropriate 

continuous phase equations have to be updated with a discrete phase trajectory 

calculation. 

(5)Finally, the convergence of the equations set is checked and all the procedure is 

repeated until convergence criteria are met. 

The conservation equations are linearized according to the implicit scheme with 

respect to the dependent variable: the result is a system of linear equations (with one 

equation for each cell in the domain) that can be solved simultaneously. Briefly, the 

segregated implicit method calculates every single variable field considering all the 

cells at the same time. The code stores discrete values of each scalar quantity at the 

cell center; the face values must be interpolated from the cell center values. For all the 

scalar quantities, the interpolation is carried out by the second order upwind scheme 

with the purpose of achieving high order accuracy. The only exception is represented 

by pressure interpolation, for which the standard method has been chosen. 

1.2.4.3. Post-Processing: 

This is the final step in CFD analysis, and it involves the organization and 

interpretation of the predicted flow data and the production of CFD images and 

animations. Fluent software includes full post processing capabilities. FLUENT 

exports CFD’s data to third party post-processors and visualization tools such as 

Ensight, Fieldview and TechPlot as well as to VRML formats. In addition, FLUENT 

CFD solutions are easily coupled with structural codes such as ABAQUS, MSC and 

ANSYS, as well as to other engineering process simulation tools. 

Thus FLUENT is general-purpose computational fluid dynamics (CFD) software 

ideally suited for incompressible and mildly compressible flows. Utilizing a pressure 

based segregated finite-volume method solver, FLUENT contains physical models for 

a wide range of applications including turbulent flows, heat transfer, reacting flows, 

chemical mixing, combustion , and multiphase flows, FLUENT provides physical 

models on unstructured meshes, bringing you the benefits of easier problem setup and 

greater accuracy using solution-adaptation of the mesh. FLUENT is a computational 

fluid dynamics (CFD) software package to simulate fluid flow problems. It uses the 

finite-volume method to solve the governing equations for a fluid. It provides the 
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capability to use different physical models such as incompressible or compressible, 

inviscid or viscous, laminar or turbulent etc. 

Geometry and grid generation is done using GAMBIT which is the pre-processor 

bundled with FLUENT. Owing to increased popularity of engineering work stations, 

many of which has outstanding graphics capabilities, the leading CFD are now 

equipped with versatile data visualization tools. These include: Domain geometry & 

Grid display, Vector plots, Line & shaded contour plots, Particle tracking, View 

manipulation (translation, rotation, scaling etc.). 

1.2.5. ADVANTAGES AND DISADVANTAGES 

• No restriction to linearity. 

• Complicated physics can be treated. 

• Time evaluation of flow can be obtained. 

• It has the potential of providing information not available by other means. 

• Computational investigation can be performed with remarkable speed. 

Designer can study the implications of hundreds of different configurations in 

minimum time and choose the optimum design. 

• It gives detailed and complete information. It can provide the values of all the 

relevant variables (pressure, velocity, temperature, concentration, turbulence) 

throughout the domain of interest.   

• Truncation errors. 

• Boundary condition problems. 

• Computer costs. 

• Computer storage & speed. 

1.2.6. APPLICATIONS OF CFD 

• Aerodynamics of aircraft & Space vehicles: lift & drag. 

• Hydrodynamics of ships. 

• Weather prediction. 

1.2.7. PREDICTING THE TURBULENT VISCOSITY 

The following models can be used to predict the turbulent viscosity: 

• Mixing length model. 

• Spalart – Allmaras model. 

• Standard k-ε model. 
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• k-ε Realizable model. 

• k-ω Model. 

1.2.7.1. The k-ε model: 

• The k-ε model focuses on the mechanisms that affect the turbulent 

kinetic energy (per unit mass) k. 

• The instantaneous kinetic energy k(t) of a turbulent flow is the sum of 

mean kinetic energy and turbulent kinetic energy k : 

                                           K= 
1

2
(𝑈2 + 𝑉2 + 𝑊2) 

                                           k = 
1

2
 (𝑢′2 + 𝑣′2 + 𝑤′2) 

                                           k(t) = K + k 

ε is the dissipation rate of k. 

• If  k and ε are known, we can model the turbulent viscosity as: 

𝑣𝑡 𝞪 9λ 𝞪  𝑘1/2 𝑘3/2

𝜀
 = 

𝑘2

𝜀
 

• We now need equations for k and ε. 

1.2.7.2. Turbulent kinetic energy k: 

The equation for the turbulent kinetic energy k is as follows: 

Here 𝑒𝑖𝑗
′ is fluctuating component of rate of deformation tensor. 

 
𝜕(𝜌𝑘)

𝜕𝑡
 + div(𝜌kU) = div(- 𝜌′𝑢′ + 2𝜇𝑢′𝑒𝑖𝑗

′ - 𝜌
1

2
𝑢𝑖

′𝑢𝑖
′𝑢𝑗

′ )-2𝜇𝑒𝑖𝑗
′𝑒𝑖𝑗

′ + (-𝜌𝑢𝑖
′𝑢𝑗

′. 𝐸𝑖𝑗) 

(1)        (2)                       (3)          (4)           (5)                    (6)                 (7) 

The equation can be read as: 

(1) The rate of change of k, plus 

(2) Transport of k by convection, equals 

(3) Transport of k by pressure, plus 

(4) Transport of k by viscous stresses, plus 

(5) Transport of k by Reynolds stresses, minus 

(6) Rate of dissipation of k, plus 

(7) Turbulence production. 
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1.2.7.3. Turbulent dissipation: 

The equations look quite similar. 

However, the k equation mainly contains primed quantities, indicating that 

changes in k are mainly governed by turbulent interactions.  

Furthermore, term (7) is equal in both equations. But it is actually negative 

in the K equation (destruction) and positive in the k equation: energy 

transfers from the mean flow to the turbulence. 

The viscous dissipation term (6) in the k equation  

                               K= -2µ𝑒𝑖𝑗
′𝑒𝑖𝑗

′      

describes the dissipation of k because of the work done by the smallest 

eddies against the viscous stresses. 

We can now define the rate of dissipation per unit mass ɛ as: 

                                  ɛ= 2v𝑒𝑖𝑗
′𝑒𝑖𝑗

′ 
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2.LITERATURE REVIEW 

Various wind tunnels of close loop type have been existed and being developed for 

applications in aerodynamics and wind engineering. Now-a-days these are being 

applied for experimentation of PCB cooling. 

Recent developments in computational methods have significantly increased the use 

of numerical models. (Ghani et al., 2001; Launder and Spalding, 1972; Gartmann et 

al., 2011). Numerical methods are often used jointly with physical experimentation 

such as wind tunnel studies for validation and assessment of data obtained by 

simulation. However, the use of CFD to support wind tunnel design has remained 

very limited and has been situated in other research areas (Moonen et al., 2006; 

Moonen et al., 2007). Several works on the evaluation of wind tunnel systems using 

numerical models are highlighted in this section 

John Kaiser Calautit (2014) Validated a design methodology for a closed loop 

subsonic wind tunnel where a systematic investigation into the design and simulation 

of flow parameters in a closed-loop wind tunnel was carried out using Computational 

Fluid Dynamics (CFD) where the analytical model for estimating pressure losses were 

directed as input boundary conditions. Full-scale model of the entire wind tunnel was 

considered instead of the conventional approach, in which only test section flow is 

simulated. This allowed for optimization of flow quality not only in the test section 

but also the flow in the entire circuit. He validated the importance of guide vanes for 

upstream and downstream flow in a closed loop wind tunnel. 

Moonen et al.(2006) established a methodology for numerically modelling the flow 

conditions in a closed-circuit low speed wind tunnel system. Steady-state and three-

dimensional CFD simulations, using standard and realizable k-epsilon equations 

models, were carried out to determine the total pressure loss and flow rate in the test 

section. Grid sensitivity analysis was performed to verify the grid independence of the 

simulation of results for both the cases. The study showed that the accuracy of the 

results from the full wind tunnel model simulation was 2 to 4 times better than the 

conventional CFD analysis of only the test section. 

Gordon and Imbabi (1998) used CFD to simulate the flow with in critical sections of 

the closed-loop wind tunnel at the University of Aberdeen. The study aimed to reduce 
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the overall cost and size of the wind tunnel, facilitate the use of alternative working 

fluids and at the same time maintain the high quality of the flow in the test section. 

The results showed that the CFD methods played a significant part in classifying the 

required modifications to achieve compact and cost effective wind tunnel design. 

Moonen et al.(2007) investigated the flow quality in the test section of a closed loop 

wind tunnel test using numerical analysis. The work established six corresponding 

indices for the evaluation of the three-dimensional flow quality in the test section. The 

study highlighted the effect of adding guide vanes and mesh screens in the contraction 

nozzle to improve the flow quality in the working section. The findings depicted that 

the vertical guide vanes reduced the skewness and angularity, yielding a higher 

quality flow while the horizontal guide vanes were found to have a slightly negative 

impact. 

Chad Harris et al.(2000) Where a cross flow micro heat exchanger was designed to 

maximize heat transfer from a liquid (water-glycol) to a gas (air) for a given frontal 

area while holding pressure drop across the heat exchanger of each fluid to values 

characteristic of conventional scale heat exchangers. The predicted performance for 

these plastic, ceramic, and aluminum micro heat exchangers are compared with each 

other and to current innovative car radiators. The cross flow micro heat exchanger can 

transfer more heat/volume or mass than existing heat exchangers within the context of 

the design constraints specified which can be applied in a wide range of applications 

(automotive, home heating, and aerospace) where the basic idea for introducing a 

radiator was visualized. 

Muhammad Mahmood Aslam Bhutta et al (2012) Where the applications of 

Computational Fluid Dynamics (CFD) in the field of heat exchangers. It has been 

found that CFD has been employed for the following areas of study in various types 

of heat exchangers: fluid flow maldistribution, fouling, pressure drop and thermal 

analysis in the design and optimization phase. Different turbulence models available 

in general purpose commercial CFD tools i.e. standard, realizable and RNG k _ ε 

RSM, and SST k _ ε in conjunction with velocity-pressure coupling schemes such as 

SIMPLE, SIMPLEC, PISO etc. have been adopted to carry out the simulations. The 

quality of the solutions obtained from these simulations are largely within the 
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acceptable range proving that CFD is an effective tool for predicting the behavior and 

performance of a wide variety of heat exchangers. 

From the previous related work, different types of wind tunnels have been studied 

using numerical CFD analysis. The numerical simulation and experimental results 

demonstrated the importance of the use of CFD in assessing the performance of a 

wind tunnel system. 

We took a liberty of designing and simulating a conceptual triangular shaped closed 

loop wind tunnel with guide vain radiator which have the flexibility in the functioning 

like a guide vain as well as radiator for cooling so that it overcomes the disadvantage 

of heat generated in the wind tunnel due to repeated circulating air on the other hand 

decreasing the overall head loss in the wind tunnel.  
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3.WHY 45° CORNER WIND TUNNEL? 

A regular rectangular shaped closed loop wind tunnel has four corners and a radiator 

to cool down the heat generated due to the continuously flowing fluid. The major 

head losses are formed at the four corners and due to the radiator. 

In order to reduce the head losses formed due to the four corners, the design is 

modified to two-corner (45° each) wind tunnel of triangular type. Due to this 

geometry, the 45° corner has more head loss compared to a 90° corner. Since there are 

less number of corners in a triangular shaped wind tunnel (2) when compared to a 

rectangular one (4), the overall head loss can be compensated. 

Guide vanes play an important role in the uniformity of fluid flow especially at the 

corners. Non-uniform flow of fluid in the wind tunnel effects the results in the test 

chamber during experimentation. 

3.1. GEOMETRY OF 45° CORNER AND 90° CORNER: 

A 45° corner and a 90° corner are developed such that the inlet and outlet of both the 

corners comprises the same length and the area of the flow is also the same. 

Fig.3.1. 2D geometry of 90° corner 
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Fig.3.2. 2D geometry of 45° corner 

 

 

Fig.3.3. 2D geometry of 90° corner with guide vanes 
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Fig.3.4. 2D geometry of 45° corner with guide vanes 

 

3.2. AIR FLOW WITH AND WITHOUT GUIDE VANES: 

Taking the same boundary conditions for both the corners, flow simulation has been 

done to get the flow properties using ANSYS FLUENT with and without guide vanes. 

Summary of CFD models boundary conditions. 

Parameter  Set value 

Discretization scheme Second-order upwind  

Algorithm  SIMPLE 

Time  Steady state 

Velocity inlet  0.5 m/s 

Pressure outlet 0 pa 

Gravity  -9.81 m/s 

Table.3.1. Boundary conditions 

The velocity contours obtained are as follows: 
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Fig.3.5. Without guide vanes 

 

Fig.3.6. With guide vanes 

From the results, corners with guide vanes produce uniform flow which is essential 

for wind tunnel. 
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3.3. HEAD LOSS AT THE CORNERS: 

Pressure simulations for both the corners with guide vanes are done in Results-CFD-

post and functional calculator is used to find average pressures at inlet and outlet of 

2D corners for head losses calculations. 

 

Fig.3.7. Pressure calculation by function calculator 

90° simulation 45° simulation 

Average of Pressure on inlet 

P1 = 0.0538592 pa 

Average of Pressure on outlet 

P2 = 0 pa 

head loss = 
(𝑃1−𝑃2)

𝜌∗𝑔
 

ρ = density of air 1.225 kg/m3 

g = gravitational acceleration 9.81 m/s 

head loss = 0.0044818 m 

Average of Pressure on inlet 

P1 = 0.0969496 pa 

Average of Pressure on outlet 

P2 = -1.82078*10-5 pa 

head loss = 
(𝑃1−𝑃2)

𝜌∗𝑔
 

ρ = density of air 1.225 kg/m3 

g = gravitational acceleration 9.81 m/s 

head loss = 0.00806905 m 

Table.3.2. Overall head loss 
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Since there are 4 corners in rectangular wind tunnel the overall head loss due to 

corners is 4 times the head loss of a 90° bend and it will also have radiator head loss if 

it is introduced. 

90° Overall head loss = 4*head loss due to 90° corner + radiator head loss 

   = 4*0.0044818 + radiator head loss 

= 0.0179272 m + radiator head loss 

But in the conceptual triangular shaped wind tunnel will have 3 corners in which two 

of them were 45° corners the other corner is compensated by a centrifugal blower for 

circulation of air where there is an advantage of involving radiator within the guide 

vane itself. So overall head loss due to corners is 2 times the head loss of a 45° bend. 

45° Overall head loss = 2*head loss due to 45° corner 

   = 2*0.00806905 

   = 0.0161381 m 

Here as the overall head loss in 45° corner is less than the overall head loss in 90° 

corner, the 45° is preferred to reduce the overall head loss. 
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4.DESIGN PROCEDURE IN SOLID WORKS 

4.1. DESIGN OF EFFUSER: 

• In SolidWorks, select the right plane and develop a square of 1x1 m2 and at a 

distance of 1.3 m, develop another square of 0.5x0.5 m2. 

• Now develop a plane such that it should cut the two squares diagonally. In 

that plane join the two squares at the corner points by a curve on both sides 

where the plane cuts the two squares. 

• Then the figure has to be extruded to get the Effuser. 

• A provision has to be developed by extruding the bigger square to a length of 

0.2m. 

 

 

 

Fig.4.1.Effuser 

   

4.2. DESIGN OF TEST SECTION: 

• In the right plane, develop a square of 0.5x0.5m2 and extrude it to 1m. 
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Fig.4.2. Test chamber 

4.3. DESIGN OF DIFFUSER: 

• In the right plane, develop a square of 0.5x0.5 m2 and another rectangle of 

1x0.75 m2 and extrude it such that it has an area ratio of 1:3 and an included 

angle of 8° and 4°.

Fig.4.3. Diffuser 

4.4. DESIGN OF 45° CORNER: 
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• Develop the outline of the vane in such a way that the inlet and outlet are of 

lengths 0.75m, their perpendiculars coincided at 45° to each other and the inlet 

and outlet are joined by arcs of radii 0.075m and 0.150m as shown. 

Fig.4.4. 45°corner design step 1 

• For the guide vane radiators, the available length of inlet and outlet (0.75m) is 

divided into 10 equal parts each of length 0.075m. 

• Develop a provision for guide vane radiator taking 0.15m as lower circle 

radius and center as that point which is used for developing an arc of 0.075m 

radius (used for joining the inlet and outlet) .The radius of the upper arc of the 

guide vane radiator should be taken as 0.075m and a suitable center such that 

all the nine vanes are equally spaced. The two obtained arcs are then joined by 

lines. A chamfer of radius 0.005 is given at the corners to obtain the guide 

vane radiator. 

• Similarly provisions for all the nine guide vanes are developed. 
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Fig.4.5. 45°corner design step 2 

 

• The obtained figure is extruded to 1m to get the 45° vane and extrude cut to get 

the provisions for guide vane radiators. 

 

Fig.4.6. 45°corner design step 3 

 

4.5. GUIDE VANE RADIATOR: 

• As mentioned earlier, a guide vane radiator is developed with the given 

dimensions. 
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. 

 

Fig.4.7. Individual radiator 

 

• The guide vane radiators are mated with the 45° vane to get the final Guide Vane 

Radiator assembly. 

Fig.4.8. Assembly 1 

4.6. HYPOTENUSE DUCT: 

• A rectangle of 0.75x1 m2 is drawn in the top plane and extruded to 5.4m to obtain 

the hypotenuse duct. 
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Fig.4.9. Hypotenuse duct 

4.7. SIDE DUCT: 

• Another duct of dimensions 0.75x1 m2 is drawn and extruded to 3.6m to obtain 

the duct. 

4.8. FINAL ASSEMBLY: 

• All the individually developed parts are assembled using face mates to get the 

final assembly. 

Fig.4.10. Final assembly 
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5. a. MODE OF OPERATION 

Fig.5.1. Line diagram 

The wind is made to flow through the tunnel through the effuser section of 1m x 1m 

area. In order to get a smooth flow, the effuser is equipped with a series of honey 

combs having narrow way to drive the wind blowing from all directions into a 

horizontal path. The wind flows through the honey combs and enters the contraction. 

Here the area of the section goes on decreasing up to 0.5m x 0.5m to have an increase 

in velocity by decreasing pressure. 

From there, the wind enters the test section of 0.5m x 0.5m, where the body to be 

tested is placed for experimentation. In the test section, to view the results, sensors are 

generally employed. The air after passing through the test section diffuses in the 

diffuser having inlet area of 0.5m x 0.5m and outlet area of 0.75m x 1m with included 

angles of 4° and 8°. 

The air enters the 45° corner and changes its direction. Guide vanes direct the air to a 

specific direction without compromising on the uniformity. The guide vanes are so 
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designed that they also have a provision for the flow of coolant through it so that 

cooling of the air takes place without use of the radiator. The inner walls of the guide 

vanes are made of copper due to high thermal conductivity. Hence the guide vanes 

can be used both for directing the air and also for the cooling purpose. The air is then 

made to flow in a straight path of 0.75m x 1m area and length 5.4m called hypotenuse 

to reach another 45° corner. The air again follows the same procedure as done in the 

previous 45° corner and decreases the temperature of air to a much lower value. Then 

finally the air is made to flow through a duct of 0.75m x 1m area and 3.6m length to 

reach the contraction section. 

The same air is made to circulate in the same manner and cooling is also done 

simultaneously to get the results in test section at a specific point based on the 

requirement. 
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5.b.  OBTAINING INPUTS TO THE FLOW 

As the wind tunnel is designed for subsonic flow where there will not be any 

compressibility air in the wind tunnel. The continuity equation holds good, from 

previous journals we had assumed that the velocity at the inlet of test chamber and 

outlet of effuser is 16 m/s 

Considering effuser  

Area at the outlet of the effuser A2 = 0.25m2 

Area at the inlet of the effuser A1 = 1m2 

Velocity at the outlet of effuser, inlet of test chamber V2 = 16 m/s 

Velocity at the inlet of effuser V1 =? 

 

Continuity equation: A1V1 = A2V2 

V1 = 
𝐴2∗𝑉2

𝐴1
 

     =
0.25∗16

1
 

     = 4 m/s 

From the above equation input condition is obtained which is used in ANSYS 

simulation for velocity input boundary condition.  
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6. SIMULATION IN ANSYS WORKBENCH 

• ANSYS R 15.0 is used to do the simulations in Analysis System → Fluid Flow 

(Fluent) 

• Then a dialogue box appears in Project Schematic as shown below 

 

Fig.6.1. ANSYS WORKBENCH 

• It was named as velocity eaternal 1.0 

6.1. GEOMETRY: 

• Select geometry (bourse) → Input, to input IGS file of eaternal which was 

exported in solid works assembly. 

• Click import → Generate, all the solid objects are generated as they were created 

in solid works. 

• Then the objects are differentiated and united using Boolean operation by, Create 

→ Boolean → Named selection 

• Using fill operation, the gaps between the radiator are filled, Tools → Fill → 

Named selection 

• Some of the faces which are default created are merged using merge operation 

Tools → Merge → Face selection 
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Fig.6.2. Air domain 

 

Fig.6.3. Radiator 1 
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Fig.6.4. Water domain 1 

 

Fig.6.5. Radiator 2 and water domain 2 

In order to know the velocities for heat transfer calculations; radiator 1, radiator 2, 

water domain 1 and water domain 2 were suppressed and only air domain is 

considered. 

6.2. MESHING: 

• Right click to the Mesh → Edit, to the body 
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• Sizing: on the proximity and curvature for better results, due to computational 

limits of Relevance: coarse, Smoothing: medium 

• Proximity min size:0.4 cm, Max face size:46 cm, Max size:92 cm  

• For better accuracy of flow refinement is done on faces of test chamber, Mesh 

→ Insert → Refinement and rest were set to default 

• Mesh is generated, Mesh → Generate mesh, Inlet and outlet conditions are 

defined using named selections 

 

Fig.6.6. Mesh of air domain 

 

Fig.6.7. Boundary condition 
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6.3. SETUP: 

• Setup → Edit → Double precession on → Parallel 4 processers is set → OK 

• General 

Type → Pressure based, Velocity formation → Absolute, Time → Steady 

Gravity = 9.81m/s 

• Modes  

k-epsilon → Realizable →Enhance wall treatment 

• Materials 

Fluent database → air → copy 

• Cell zone condition  

Add material → air → OK 

• Boundary conditions 

Air inlet → velocity inlet = 4 m/s 

Air outlet →pressure outlet = 0 pa 

6.4. SOLUTION: 

• Solution methods 

Scheme → SIMPLE, Gradient → Least square cell method, Pressure → 

second order, Momentum → second order upwind 

• Solution initialization  

Hybrid initialization is done 

• Run calculations due to hard ware limit 5 iterations were done  

• All the above conditions are very much feasible in increases the accuracy of 

velocity and pressure contours  
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7. HEAT TRANSFER IN THE GUIDE VANE RADIATORS 

When two fluids having different temperatures come in contact either directly or 

indirectly, heat transfer takes place between the two fluids. This heat transfer depends 

on the inlet temperatures of the fluids, heat transfer coefficient of the medium and the 

velocities with which the fluids come in contact. 

As the air flows continuously in the tunnel, the temperature of air increases and it has 

to be cooled down. 

If the temperature of air is increased to 60°C, it has to be brought back to the ambient 

temperature before the start of next cycle. As two 45° corners are available for the 

cooling purpose, the cooling procedure is divided into two phases, where the first 

phase includes cooling down the temperature from 60°C to 45°C and in the second 

phase, cooling is done to reduce the temperature from 45°C to ambient temperature 

i.e. 30°C. 

 

7.1. HEAT TRANSFER IN THE FIRST 45° CORNER: 

Inlet temperature of the air  = 60°C 

Outlet temperature of the air  = 45°C 

Outlet temperature of the water = 40°C 

Velocity of air    = 4 m/s 

Let,  the inlet temperature of water be ‘Tin’ 

 Velocity of water be ‘V’ 

Here,  

Heat loss by the air  =  Heat gain by the water 

(m*Cp*∆T)air  = No. of vanes*(m*Cp*∆T)water 

As m = ρ*A*V, 

 (ρ*A*V*Cp *∆T)air = 9*(ρ*A*V*Cp*∆T)water  

 1.06*0.7*4*1*(60-45)= 9*1000*0.0140*V*4.2*(40-Tin) 

 V*(40-Tin)  = 0.084127 

 

A graph is plotted between V and Ti in MATLAB to find the inlet velocity of water. 
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Fig.7.1. Velocity vs inlet temp. of water in first corner 

From the graph, the required inlet temperature of water and the velocity of water are 

determined. 

 

7.2. HEAT TRANSFER IN THE SECOND 45° CORNER: 

Inlet temperature of the air  = 45°C 

Outlet temperature of the air  = 30°C 

Velocity of water   = 0.0084127 m/s (from first corner) 

Let,  the outlet temperature of water be ‘Tout’ 

 Inlet temperature of the water be ‘Tin’ 

 

Here,  

Heat loss by the air  =  Heat gain by the water 

 (m*Cp*∆T)air  = No. of vanes*(m*Cp*∆T)water  

As m = ρ*A*V, 

 (ρ*A*V*Cp *∆T)air = 9*(ρ*A*V*Cp*∆T)water  

 1.06*0.7*4*1*(45-30)= 9*1000*0.0140*0.0084127*4.2*(Tout -Tin) 

 (Tout -Tin)  = 10°C 
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A graph is plotted between Tout and Tin in MATLAB to find the corresponding inlet 

and outlet temperature of water.

 

Fig.7.2. Outlet temp vs inlet temp in second corner 

From the graph, the inlet and outlet temperatures of the water differ by 10°C. So 

based on the graph, suitable temperatures are taken and given as the conditions for the 

flow of water. 

Hence the heat transfer takes place between the air and water to bring down the 

temperature of the air to the required temperature by passing the water through the 

guide vane radiators. Thus, the cooling process can be achieved without the use of 

radiators.  
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8. RESULTS 

The flow profile inside the wind tunnel which was obtained is shown below. The 

velocity variation within the test section is significantly low which is very much 

important for experimentation purposes. The average velocity in the test chamber is 

16.73 m/s  

 

Fig.8.1. Front view of simulation 
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Fig.8.2. Bottom view of simulation 

Fig.8.3. velocity scale 
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Fig8.4. Horizontal view of test section 

 

 

Fig8.5. Vertical view of test section 

 

By using functional calculator in CFD post- results total pressure loss was calculated  
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Fig.8.6. Air inlet and outlet pressure 

Average of Pressure on air inlet P1 = 41.0604 pa 

Average of Pressure on air outlet P2 = 0 pa 

Total pressure loss P = P1 – P2 

                          = 41.0604 pa 

By this the total pressure loss throughout the wind tunnel is 41.0604. It should be 

provided by the centrifugal blower to have average velocity 16 m/s at the test 

chamber. 
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9. CONCLUSION 

The wind tunnel is designed and developed in SolidWorks. Various components of 

the wind tunnel are created and then all the components are assembled based on the 

required dimensions. Guide vane radiators are introduced into the 45° corners to get 

the final wind tunnel assembly with guide vanes. The regular closed loop wind tunnel 

is of rectangular type having four 90° corners. It is replaced by two 45° corners so that 

the total head loss is decreased. The guide vanes are also provided with some 

provisions in order to pass the coolant to decrease the temperature of the continuously 

flowing air. Hence it can act as a radiator and moreover the head loss due to radiator 

is eliminated. The fluid simulation is done in the designed wind tunnel and a uniform 

flow of wind in the tunnel is achieved which can be shown as a proof that the 

designed model can be presented. For the heat transfer, the necessary equations are 

taken and applied at the air-water boundary and the inlet conditions of the water are 

derived which can be used for achieving the required heat transfer. 

Therefore, with the designed wind tunnel, head loss due to corners and radiator is 

decreased and a new mode of cooling is introduced without any loss of other factors. 

 

9.1. Future Scope: 

• A Centrifugal blower which is suitable for inlet boundary condition is to be 

created. 

• Proper circulation system for cooling fluid can be created. 

• Analysis of a test specimen in this wind tunnel can be done. 

• Concept of guide vane radiator can be applied in various other situations. 
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